Contents

1. Welcome to COPA-DATA help ................................................................. 4

2. zenon Operator .................................................................................... 4

3. Restrictions for the zenon Operator .................................................. 5
   3.1 Special restrictions for CE version .................................................... 8

4. zenon for Windows CE ......................................................................... 13
   4.1 General ............................................................................................ 14
      4.1.1 Create projects for CE ................................................................. 14
      4.1.2 Licensing ................................................................................ 15
   4.2 Requirements .................................................................................. 16
      4.2.1 CE - versions and process support ............................................ 17
      4.2.2 Compatibility ........................................................................... 18
   4.3 System files ..................................................................................... 18
      4.3.1 20% Rule ................................................................................ 19
      4.3.2 Runtime .................................................................................. 21
   4.4 Network ........................................................................................... 23
      4.4.1 Network settings ...................................................................... 24
      4.4.2 CE terminal as server ............................................................... 25
      4.4.3 CE terminal as client ............................................................... 28
      4.4.4 Possibilities for diagnosis ......................................................... 29
      4.4.5 CE terminal as data server ..................................................... 31
   4.5 Connection via Activesync or Windows Mobile Device Center .......... 34
      4.5.1 USB connection under Windows 7 ............................................. 34
      4.5.2 Serial connection under Windows XP ....................................... 35
      4.5.3 Update Windows CE Runtime .................................................. 39
   4.6 Recipegroup Manager ...................................................................... 47
   4.7 Transparency ................................................................................... 48
   4.8 Pocket PC and Windows Mobile Edition .......................................... 49
1. Welcome to COPA-DATA help

GENERAL HELP
If you miss any information in this help chapter or have any suggestions for additions, please feel free to contact us via e-mail: documentation@copadata.com (mailto:documentation@copadata.com).

PROJECT SUPPORT
If you have concrete questions relating to your project, please feel free to contact the support team via e-mail: support@copadata.com (mailto:support@copadata.com)

LICENSES AND MODULES
If you realize that you need additional licenses or modules, please feel free to contact the sales team via e-mail: sales@copadata.com (mailto:sales@copadata.com)

2. zenon Operator
The zenon Operator is adapted to machine operation. It consists of Editor and Runtime. The Runtime is available for PC operating systems and CE operating systems. For Windows CE there a restrictions determined by the system.

The principle functionality conforms with the zenon Supervisor. Towards the zenon Supervisor the Operator has functional restrictions (on page 5).
For editing an Operator project, you can either use the Editor of the zenon Operator or the Editor of the zenon Supervisor. If you engineer functionalities in the Supervisor Editor which are not available in the Operator Runtime, they are simply not executed.

### 3. Restrictions for the zenon Operator

The zenon Operator can be used on embedded operating systems. Its functionalities differ from the ones of the zenon Supervisor. The Windows CE operating system brings additional restrictions for the zenon Operator. You can find details in the following overview:

**Key:**

- `+`: Standard
- `*`: possible
- `-`: not possible
- `o`: licensable as an optional module
<table>
<thead>
<tr>
<th>Features Operator Runtime</th>
<th>for PC</th>
<th>for CE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dongle licensing</td>
<td>*</td>
<td>-</td>
</tr>
<tr>
<td>64 - 8192 TAGs</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>Direct X/Graphics</td>
<td>*</td>
<td>-</td>
</tr>
<tr>
<td>Global project</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>Multi-project in the Editor</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>(only 1 project plus global project)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Multi-project in the Runtime</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>(only 1 project plus global project)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Modules</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Historian</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Historian Starter Edition</td>
<td>o</td>
<td>o</td>
</tr>
<tr>
<td>(CE 6.0 or above)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Automatic Line Coloring (ALC)</td>
<td>o</td>
<td>o</td>
</tr>
<tr>
<td>Extended Trend</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Extended Trend Starter Edition</td>
<td>o</td>
<td>o</td>
</tr>
<tr>
<td>(CE 6.0 or above)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Industrial Maintenance Manager</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Industrial Performance Analyzer</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Message Control including Text To Speech Engine</td>
<td>o</td>
<td>-</td>
</tr>
<tr>
<td>Production and Facility Scheduler (PFS)</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>(Scheduler available)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(Scheduler available)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Restrictions for the zenon Operator

<table>
<thead>
<tr>
<th>Module</th>
<th>Report Generator (without data storage)</th>
<th>RDL Viewer</th>
<th>Recipegroup Manager</th>
<th>Driver: 1 driver included, exceptions Energy driver (IEC870-101/103/104, IEC850, DNP3, Modbus Energy)</th>
<th>Driver: several instances</th>
<th>S7 Graph</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>o</td>
<td>o</td>
<td>o</td>
<td>*</td>
<td></td>
<td>o</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(CE 6.0 or above)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Network

<table>
<thead>
<tr>
<th>Module</th>
<th>zenon network</th>
<th>Redundancy</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>+</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(only Server Client)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Module</th>
<th>zenon web server light, 3 clients. Only with connection to the local Runtime</th>
<th>zenon Webserver.</th>
<th>zenon Web client</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>o</td>
<td>o</td>
<td>o</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Programming interfaces

<table>
<thead>
<tr>
<th>Module</th>
<th>Process Control Engine (PCE)</th>
<th>VBA/VSTA</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>+</td>
<td>-</td>
</tr>
</tbody>
</table>

#### zenon Logic

<table>
<thead>
<tr>
<th>Module</th>
<th>zenon Logic Monitoring Viewer</th>
<th>zenon OPC Server</th>
<th>zenon SQL Server</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>o</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

All not mentioned modules/functionalities are available with the zenon Operator.
ZENON OPERATOR EDITOR

For the Operator Editor the following is available as an option:

- zenon Logic Monitoring Builder
- zenon Logic Workbench Pro
- VBA/VSTA

3.1 Special restrictions for CE version

MODULES WHICH ARE AVAILABLE IN WINDOWS CE 6.0 AND HIGHER VERSIONS:

- Historian Starter Edition
  Restrictions see manual Historian, chapter Historian Starter Edition.

- Extended Trend Starter Edition
  Restrictions see manual Extended Trend.
  In addition the following control elements are not available in CE projects:
  - Diagram button
  - Curve button
  - Diagram settings
  - Print dialog
  - X axis button
  - Cursor output window
  - Filter profiles

- Recipegroup Manager

ACKNOWLEDGE ALARM STATUS LINE

In Windows CE you cannot acknowledge the alarm status line with a right click.

ARCHIVING

For archiving only the Historian Starter Edition is available for Windows CE. It has a few restrictions compared to the Historian. For details see chapter Historian Starter Edition in manual Historian.
RESOLUTION OF THE CE DEVICE AND DISPLAY OF THE CEL AND AML FILTER DIALOGS

The Alarm administration and the Chronological Event List (CEL) permit a filter selection in the Runtime. However, it can only be used with a resolution of 800x600 or higher. The Profile administration in the corresponding screens is not available. As a consequence, the buttons Save and Delete do not work. As the Print dialog cannot be executed in Windows CE, the corresponding button does also no longer work.

SCREEN TYPES WHICH ARE NOT AVAILABLE:

- Variable diagnosis
- Video

USER ADMINISTRATION

Active Directory and ADAM/AD LDS are not available with Windows CE.

DYNAMICS

Dynamics such as rotation, changing height and width or X and Y position are not available.

DYNAMIC ELEMENTS

ACTIVEX ELEMENTS: REGISTRATION IN WINDOWS CE:

Active X – Elements must be registered before they can be used in CE. You can find help on this in the chapter entitled 'Engineering hints - Active X'.

UNIVERSAL SLIDER

The display as Ribbon is not available.

XAML AND WPF FILES

WPF is not available. Therefore XAML which is used as description language for WPF is not used.
FILTER IN AML AND CEL

The filters for the Alarm Message List and for the Chronological Event List cannot be engineered if property Windows CE project is activated. As these dialogs are very large this limitation was introduced in order to ensure the operability even on small displays (PDAs). If you create a Windows CE project without activating property Windows CE project, you can use the filter dialogs as usual.

FILTER PROFILES

It is not possible to work with profiles in Runtime under Windows CE.

FREELY DEFINABLE FRAME SHAPE

For frames the Freely defineable frame shape is not available under Windows CE.

GRAPHICS

3D FILLING PATTERNS

3D patterns are available but need more graphic resources of the CE terminals. So they are not recommended.

GRAPHICS QUALITY

Graphics functions, which are provided by setting Windows enhanced in property Graphics quality such as filling, transparency, are not available in Windows CE.

Hint: Transparent GIF files (on page 48) and PNG files with restrictions can be displayed.

FILLING EFFECTS

Filling effects of static elements may be displayed differently than on a PC depending on the CE terminal.

For static elements only filling patterns complete and not filled are available for Windows CE. For the static elements there are only the following line types for Windows CE: full, dashed, without.
**GIF FILES**

To display GIF files in Windows CE, you must make sure that file IMGDECEMP.dll is available on the target device. If the file is missing, you can request it via support@copadata.com.

**LINES**

Lines cannot be displayed with rounded corners. Even if in the project properties under 'Graphical design' the function 'Extended graphic function' is disabled, rounded corners are not displayed under CE.

**DISPLAY OF THE RECIPE NAMES**

In the screen of type Recipegroup Manager the recipe names can only be displayed in a combobox. The display of the listbox (via Style L) is not supported by CE platforms.

**MAIN MENUS**

Under Windows CE only the standard main menus can be displayed. It is not possible to change color, font size or font type.

**LICENSING (DONGLE)**

Dongle licensing is not available for Windows CE, neither locally nor with a network dongle.

**MULTI-PROJECT CAPABILITY**

Windows CE does not offer Multi-project capability, i.e. only one project can run at a time. This is the reason why there can be no hierarchies (main project, integration project) in network projects. This limitation does not apply to the global project.

**PROJECT SIZE**

In Windows CE, only a certain amount of memory is available.

In Windows CE 5.x the application can only be carried out on Slot0 and is therefore restricted to 32 MB. When Windows CE 5.x is started, the rest of the memory - depending on the size of the image (between 15 and 19 MB) - is still available for zenon. Because of the 20% rule 25,6 MB can be used for image, zenon and project.

As of Windows CE 6.0 the memory is limited to 2 GB. The 20% rule still applies.
Restrictions for the zenon Operator

INFO

20% Rule: After calling all zenon screens, there must still be at least 20% free memory. If this limit is not considered, we cannot guarantee a trouble-free operation of zenon.

CROSS REFERENCE LIST

If a button in a CE project is linked to a function, which is not available under Windows CE, it is indicated with 'Function deleted' in the Runtime.

RIGHT MOUSE BUTTON

The function for the right double-click is not available under Windows CE.

REDUNDANCY

Redundancy combined with a CE device as client is possible. Redundancy in the sense that the CE device takes over the role of the Server or the Standby Server is not possible.

SETTING VALUES

Set value options for elements or functions do not work with macros or programs. Set point inputs are only possible with the standard dialog box or in the element with the numerical value.

If on a CE device a set value is sent to a HD variable (e.g. with the Universal slider), a certain delay will occur, because writing on a storage card is not fast enough. Delays can also occur, if set value actions are logged in the CEL and the CEL is written to the storage card for each entry (project property).

DRIVER SIMULATION

Simulation - programmed is not available for Windows CE 6.

VECTOR ELEMENTS

ARC OF A CIRCLE

In Windows CE, the static element Arc of circle is only displayed correctly with a line thickness of 1.
Attention: Thicker line arcs are also not displayed correctly in network projects. The line arcs look jagged then and do not look like the ones engineered on the PC.

SEGMENT OF A CIRCLE
The static element Segment of a circle is not available in Windows CE.

VARIABLES
Variables of data type LINT are not available in Windows CE.

WORLD VIEW DISPLAY
The world view is not available under Windows CE due to the graphics requirements.

WMF AND EMF FILES
The use of Meta Files (*.wmf) und (*.emf) is not possible.

4. zenon for Windows CE
The CE Runtime of the zenon Operator can run on different CE hardware platforms. Generally, the CE version of zenon offers the same functionalities as the PC version of zenon Operator however with some limitations which result from the lower hardware resources.

You can find detailed information about the installation of the zenon and zenon Logic Runtimes for Windows CE in these chapters:

- zenon Operator Runtime for Windows CE
- zenon Logic Runtime for Windows CE

License information
The zenon Runtime for Windows CE must be licensed.
4.1 General

Windows CE is an open, scaleable platform for a great number of devices for communication, entertainment, industrial and mobile data processing. Generally speaking Windows CE is an operating system reduced to the essential, which only needs very low hardware resources. This means, that now very low-priced hardware components can be equipped with a Windows based operating system. The newly developed standard Windows CE allows the realisation of novel devices which can communicate with each other, exchange information with Windows based PCs and connect to the internet.

Windows CE is a 32 bit operating system with functions such as multitasking and multithreading. Windows CE has an open structure and supports a great variety of devices. Windows CE is compact, and thus offers high performance even with limited memory.

Advantages of Windows CE are among others:

- quick boot up of the device as the operating system is unpacked in the memory for every boot up
- as no software can be installed on the CE device, there is no danger that abortive installations or viruses can influence the operating system
- high level of ruggedness as there a normally no moving parts (such as hard disks) in a CE device

Disadvantages of Windows CE are among others:

- limited functionality as not the whole Windows API (Application Programming Interface) is available
- slower read and write access on the Compact Flash card
- reduced life cycles of the storage media because of frequent access

The zenon Runtime with CE offers the same functionalities as with a PC. They are restricted (on page 8) by lesser hardware resources and limitations of the operating system.

4.1.1 Create projects for CE

The editor is a tool to create midgets, small or medium applications as well as major projects. The projecting tool is always the same. Independent of the platform for the projects, always the full engineering comfort is available. You have full project data compatibility independent of the resolution.
**CE-EDITOR**

For CE projects in the Editor under -> Properties -> General check box 'Windows CE Project' is activated. Thus only the functions which are available under Windows CE are activated. All other functions are grayed out. Excluding VBA: In the Editor VBA can be used for wizards. It cannot be used in the Runtime.

Depending on the license the Editor is limited to 8,192 TAGs.

**VBA UNDER CE**

In the Editor VBA can be used for wizards. It cannot be used in the Runtime.

### 4.1.2 Licensing

The Runtime for Windows CE can be licensed with the Remote Transport. When you establish the connection to the target system, you can enter the serial number and the license number for the CE version. The serial number is saved on the CE device in the `zenon6.ini` file. The activation number is saved in the registry.

**Info**

*The serial number and the activation number are not fully checked for validity when they are entered in the Remote Transport on the PC. The full check for validity is performed during the start of the Runtime on the CE device. Therefore, it is necessary to start the Runtime once after updating the serial number/activation number in order to check whether the numbers were entered correctly.*

Standard shipment includes a CE demo serial number that does not need an activation number.

**Example**

Demo serial number for CE 5.0 and Windows Mobile 5 0.19211400.0.-128

Demo serial number for CE 6.0 0.59211400.0.-256.0

The demo version for CE 5:

- is limited to
  - 2.048 variables
• a duration of 10 minutes
  ▶ contains
  • Process Control Engine (PCE)
  • zenon web server Pro

The demo version for CE 6.0:
  ▶ is limited to
  • 4.096 variables
  • a duration of 10 minutes
  ▶ contains
  • Process Control Engine (PCE)
  • Extended Trend Module (Starter Edition)
  • Historian (Starter Edition)
  • zenon web server Pro (3 clients)

⚠️ Attention

With the Windows Mobile Edition only roughly 800 - 1000 variables can be loaded depending on the available memory of the used device, the installed programs and the size of the project.

4.2 Requirements

Under Windows CE the control system is executable on the most different devices independent of the hardware manufacturer. For each combination of operating system and processor type, a special Runtime is required, that has to be compiled and maintained for this specific platform.

Minimum requirement for the CE device:

▶ 64 MB RAM memory
▶ 32 MB free hard disk space

As the processor speed strongly depends on the processor type, a minimum speed is hard to define. But generally we recommend, that the processor should have a minimal clock rate of 400 MHz.

Recommended:
Zenon for Windows CE

- 128 MB RAM or more
- 64 MB or more
- Processor with 800 MHz for ARM processors or 600 MHz for x86 architecture
- Network interface

**Info**

Runtime and projects should be stored on a permanent writable remanent memory.

CE devices with touchscreen usually have a low screen resolution. This has to be considered when creating projects. Some dialogs, e.g. the variable selection for the standard recipes, the temporary login dialog and other dialogs in the Runtime, are hard to operate or even not operable at all at a screen resolution of 320 x 240. But there is no minimal requirement in this case. The engineering hints include a guideline for engineering low resolutions.

**Attention**

Zenon must be installed in the according version. PC version and CE version of zenon have to match (same version, same service pack).

4.2.1 CE - versions and process support

In the current zenon version 7.00 the following Windows CE versions and processors are supported:

- CE 5.00 for x86
- CE 5.00 for ARMV4/V5
- CE 6.00 for x86
- CE 6.00 for ARMV4/V5

**Info**

You can find information about the supported CE versions and processors for earlier zenon versions in the corresponding documentation or you can contact the COPA-DATA support.
4.2.2 Compatibility

The zenon CE installation medium contains all previous compatible Runtime versions as ZIP file. These files contain binary data but no complete executable Runtimes.

If Runtime files are created with a newer Editor version, they perhaps need older drivers for the Runtime. To do this:

- navigate to the respective ZIP file in folder Runtime compatibility on the installation medium.
- unpack the driver from the file
- transfer the driver to the device

4.3 System files

The Windows CE Runtime requires the existence of certain system files. In case one of these files is missing, the operating system sends an error message during Runtime start, that one or various components have not been found. The following system files are required:
<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>mfc90u.dll</td>
<td>Necessary for the Runtime. On startup, an error message pops up if this file does not exist.</td>
</tr>
<tr>
<td>msvcr90.dll</td>
<td>Necessary for the Runtime. On startup, an error message pops up if this file does not exist.</td>
</tr>
<tr>
<td>atl90.dll</td>
<td>Not necessary for starting the Runtime but for the use of drivers with network connections or the use of zenon in a network. If this file does not exist, the device will not work as a client; TCP/IP driver connections will not work.</td>
</tr>
<tr>
<td>IMGDECMP.dll</td>
<td>Not necessary for starting the Runtime but necessary for displaying Transparency (on page 48) if Alpha Blending is not integrated in the operating system. Animation of GIF files is not possible with Windows CE.</td>
</tr>
<tr>
<td>VBSCRIPT.dll + JSCRIPT.dll</td>
<td>Not necessary for starting the Runtime. This file is needed for the PCE (Process Control Engine).</td>
</tr>
</tbody>
</table>

Some of these system files are installed together with the installation of zenon for CE and can be transferred to the CE device using the UpdateCE Tool. All these system files should be integrated in the operating system image of the CE device by the manufacturer.

⚠️ **Attention**

*For manufactures of Windows CE OS-images:*  
*CE versions older than 6.0 need the file toolhelp.dll. Activate the following option in Platform Manager in order that the file is available on the CE device and Toolhelp.h is available in SDK.*  
*Core OS -> Display Based Device ->Core OS Services -> Debugging Tools -> Toolhelp API. Thus the Toolhelp.dll is part of the image.*  
*Hint: Always use the most up-to-date Servicepack of the Platform Builder.*

*Note:* File toolhelp.dll is not used for Windows CE 6 and should not be used with CE 6.

### 4.3.1 20% Rule

The limitation to 32 MB memory (which is referred to as slot, see illustration) which has already been there since Windows CE 3.0 is still valid for Windows CE 5.0. It is going to be lifted with Windows CE 6.0.
Memory limitation means: In these 32 MB the Runtime (Variables, Functions, Screens, Driver, System, Files etc.) must be stored. During the start of Windows CE various drivers and system files are loaded into the memory depending on the device. Therefore the Runtime can never use the whole 32 MB.

Windows CE NET (4.xx) and CE 5.0 is still limited to 32 MB memory per application. However, the memory that is in use by the operating system or other applications in other slots, can already be used in the slot in which the runtime was started. Thanks to this update of CE.NET/CE 5.0, more memory is available for the Runtime.

Operating system and used hardware limit the maximum project size. Unlike with a PC, the memory is limited. Writing a kilobyte of data on a compact flash card for example does not take some milliseconds (as usual on a PC) but takes much more time.

Windows CE has been developed for low performance hardware that can be run without any moving parts. Only few CE devices have an active processor cooling. Often processors of CE devices take over all roles: Calculation, graphics, TCP/IP communication, serial communication etc.

On the PC these duties are done by various hardware components. Because of this essential difference the performance of a CE device can not be compared to the performance of a PC.

The maximum project size therefore depends on the device. No universally valid limit e.g. for a maximum number of variables or alarms can be defined.
Info

If after the Runtime start all screens are called at the same time and the maximum number of alarms queue in the memory, 20% of the central memory have to be empty in order to guarantee a faultless function.

*The available central memory can be found out with the system driver variable ‘Free disk space %’.*

**WINDOWS CE 6.0**

Since CE 6.0, the limitations of the operating system mentioned above no longer apply. The available memory can be fully used by every application. However, as the memory is often limited to 128MB RAM or 256MB RAM on conventional CE devices, there is still the chance of memory shortages. Especially when you use the Extended Trend & Historian Starter Edition. Therefore, the 20% rule mentioned above still applies.

**4.3.2 Runtime**

The Runtime for Windows CE consists of the following files:
<table>
<thead>
<tr>
<th>File name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>zenonrCE.exe</td>
<td>Runtime application</td>
</tr>
<tr>
<td>Cd_tooCE.dll</td>
<td>Necessary for the Runtime</td>
</tr>
<tr>
<td>ZennetsrvCE.dll</td>
<td>The control system netservice for Windows CE. Necessary for network projects.</td>
</tr>
<tr>
<td>SysSrvCE.exe</td>
<td>Transport service</td>
</tr>
<tr>
<td>LogCliLibCE.dll</td>
<td>The logserver client</td>
</tr>
<tr>
<td>zenon6.ini</td>
<td>Text file with settings for the Runtime like e.g. start project, language of the Runtime, etc.</td>
</tr>
<tr>
<td>UpdateCE.exe</td>
<td>Application, necessary for the CE Update tool.</td>
</tr>
<tr>
<td>RgermaCE.dll</td>
<td>German language file</td>
</tr>
<tr>
<td>RenglCE.dll</td>
<td>English language file</td>
</tr>
<tr>
<td>RfrancCE.dll</td>
<td>French language file</td>
</tr>
<tr>
<td>RitaliCE.dll</td>
<td>Italian language file</td>
</tr>
<tr>
<td>RrussiCE.dll</td>
<td>Russian language file</td>
</tr>
<tr>
<td>RspaniCE.dll</td>
<td>Spanish language file</td>
</tr>
</tbody>
</table>

Install the Runtime to the CE device with the entry CE Runtime Update-Programme (under menu Option).

Info

The following is true for a connection to Windows CE 6.0 with CX1000, Profibus or SYCONuni: Make sure that the file CDMemDrv.dll has been transferred to the device. CDMemDrv.dll is a Windows CE device driver. The DLL is available for x86 and for ARMV4I.

Additionally there are a number of other drivers for hardware communication. If the processor type of the CE device is recognised by the editor, the Remote Transport automatically transports the drivers used in the project to the CE device. The manner or The number of transferred files is displayed in the Output Window of the Editor.

These files always have to be compatible with the according CE version and with the according processor type. Mixing files form different CE versions or even service packs can lead to failures and unwanted side effects, and thus is not permitted.
4.4 Network

Of course zenon under Windows CE can still be used in a network. The CE terminal can be a server or a client in combination with other terminals or standard PCs. Another possibility is, that the CE terminal is used as a dataserver in combination with a PC.

Redundancy in a network is not supported under Windows CE, i.e. a CE terminal cannot be a standby server. If however PCs are used as server ans standby server, the CE terminal can connect as a client and in the case of a redundancy switch automatically connects to the current server.

Multi-project functionality is not supported under Windows CE.

If the CE Runtime should be used in a network, the following requirements have to be fulfilled:

- Network connection of the CE terminal
- TCP/IP network with full (!) name resolution
- Unique computer name and IP address in the network
- Necessary system files and Runtime on the CE terminal (Refer to chapter “Requirements”)
- Runtime licence with network support on the CE terminal
If a CE terminal is used in a network, no matter if server or client, on the CE terminal a Runtime licence with network has to be used.

Not network licence is necessary for Remote Transport!

*If this network license does not exist, zenon is automatically started as standalone and each CE device establishes an own connection to the PLC.*

### 4.4.1 Network settings

As the name resolution under Windows CE does not always exist, the computer names and the IP addresses of the CE terminal and the PC have to be defined. On the PC there is the file HOSTS for this purpose; it can be found in the directory `/Windows/System32/Drivers/ETC`. In this file the IP address and the computer name of the CE terminal have to be entered in capitals and separated by a tabstop, e.g. "192.168.0.100 WINDOWSCE2".

*Info*

> When saving the file, care that there is no file extension .txt!

The link between computer names and the IP addresses has to be defined on the PC as well as on the CE terminal, if the network does not fully support a dynamic name resolution. (In the dynamic name resolution the computer names are resolved based on the IP address). On the PC this information is stored in the HOSTS file under `/Windows/system32/drivers/etc`.

The operating system Windows CE does not support the functionality of a HOSTS file. The computer name and the IP address have to be entered in the `zenon6.ini` of the CE terminal, so that the name resolution also works correctly on the CE terminal. The following entry is needed:
Example

[IPADDR]
My computer name=my IP address
CE terminal name =CE terminal IP address

SERVERNAME=192.168.1.152

Under SERVERNAME enter the name of your server. Enter the according IP address of your server.

Example: Your server is PC0815 and has the IP address 192.52.9.32, so you enter:
PC0815=192.52.9.32

Care that the computer name is entered in CAPITALS!

other examples

[IPADDR]

WINDOWSCCEL=192.168.0.100

PC1=192.168.0.1

If the CE terminal does not know its own name, it also has to be entered here.

Attention

Do not use dynamic IP addresses, if there is no name resolution in the network.

4.4.2 CE terminal as server

In this constellation the project on the CE terminal is a server project (with limited functionality). All other computers, which connect to the terminal, are clients (PC clients, CE clients and Web clients are possible).
Used drivers are started on the CE terminal. As a CE terminal is used as the server, the functionality is also limited on the PC clients. The use of a CE terminal as a standby server is, as already mentioned, not possible.

**THIS MODEL HAS THE FOLLOWING CHARACTERISTICS:**

The CE project still has a limited functionality, i.e. no data archiving and no optional modules are available.

The CE terminal sends process data to all connected clients. Alarm administration, REMAs, mathematical calculations are handled on the CE terminal.

With many connected clients the CE terminal has to cope with rather heavy network load, which of course is not good for the performance of the CE terminal.
ENGINEERING THE CE TERMINAL AS A SERVER IN PRACTICE:

In order to be able to define the CE terminal as a server, the computer name of the CE terminal has to be entered as the server in the project configuration. Make sure, that the name is entered in capitals.

After you have finished the project, you have to transport the Runtime files to the server (CE terminal) with Remote Transport. Then one time you have to transport the Runtime files to all clients.

For the whole system only one single project has to be created. Future project changes only have to be transported to the server. In the case of project changes all clients get the new project data.

In the project only functionality supported on the CE terminal should be used. The option CE project is a useful tool for this purpose. It avoids, that you use modules (screens, functions, etc.), which are not supported under Windows CE.

In order to allow data archiving, the use of modules such as the extended trend or the Report Generator, and provide a number of clients with data without a performance loss on the operating terminal in spite of using Windows CE, the following second possibility was implemented:
4.4.3 CE terminal as client

Here the project on the CE terminal is not a server project. So the project on the CE terminal connects to a server as a client. This server can be a PC as well as another CE terminal.

This model has the following characteristics:

The CE project on the client has limited functionality, i.e. on the CE client only functionality supported by CE is available. Archives, extended Trend, Reports, etc. are not available. The project on the server however can contain such elements, if the server is a PC. On a PC client - if licenced - the full project is available. In order not to confuse the user the system offers the option: Visible under CE. If this checkbox is not activated, the according element is not displayed on the CE terminal.
The network load on the CE client is negligible, because there is always only one connection - that to the server. The drivers in this case are started at the server.

**ENGINEERING THE CE TERMINAL AS A CLIENT:**

For the whole system only one single project has to be created. This project runs on the server, which administers all data.

Engineering is done on the PC and the created Runtime files are transported to the server and the clients with Remote Transport.

If later changes in the project are done, the changed files have to be transported to the server with Remote Transport. The clients will update the changes after executing the function Reload project online.

The option CE project does not have to be activated. Thus the entire functionality of zenon is available for the project. As only a limited functional range is available on the CE side, functions that are not supported under CE will not be executed there (modules, special functions, etc.).

In order not to confuse the operating personnel by offering them screens and elements on the CE terminal, which will not work resp. are not supported there, for screens and elements the option Visible under CE can be used in the Editor. So the implementing engineer has the possibility to realise his project in the way, that a part of it is available under CE and another part only on the PC (PC server, other clients, ...).

### 4.4.4 Possibilities for diagnosis

**CE TERMINAL AS SERVER**

In order to make sure, that the CE terminal really works as a server, you can try the delete a driver used in the project with the Explorer on the CE terminal, while the Runtime is running. If this is possible, then Runtime on the CE terminal does not run as a server (applications opened exclusively cannot be deleted). It is possible that the CE terminal does not know its correct name or Runtime on the CE terminal does not have a network license.
CE TERMINAL AS CLIENT

If the client cannot establish a connection to the server, this is indicated with blue squares on the dynamic elements. The option Display status has to be activated for the elements in the properties window.

SYSTEM DRIVER

The system driver offers a variety of variables for network diagnosis.

OTHER

If the CE terminal is used in the network, it should be possible with the command: telnet \texttt{RECHNERNAME} 1100 in the command prompt, to make a connection to the CE terminal. (Cursor flashing in the top left corner). Runtime has to be started on the CE terminal.

\text{COMPUTER NAME} here means the name of the CE terminal (look it up in the Control Panel); 1100 is the port for the communication of the control system network service (\texttt{zennetsrvce.dll}).

If the connection with Telnet cannot be established, either the name resolution in the network does not work, or the Runtime on the CE terminal has no network license, or the system file \texttt{at190.dll} does not exist at the terminal.

The file \texttt{zennetsrvce.dll} for the respective platform is automatically transported to the CE terminal by Remote Transport (Remote transport all Runtime files). If this is not the case, the Runtime files for CE probably are not installed on the terminal. If in the Editor menu Option the command CE Runtime Update exists, the Runtime files for CE are installed.

If it happens, that sometimes one and sometimes another client connects, the reason might be, that both CE terminals have the same computer name. Windows CE does not generate an error message, if a computer name already is used in the network.
4.4.5 CE terminal as data server

In order to allow data archiving, the use of modules such as the extended trend or the Report Generator, and provide a number of clients with data without a performance loss on the operating terminal in spite of using Windows CE, the following possibility of the dataserver was implemented:

**THIS MODEL HAS THE FOLLOWING CHARACTERISTICS:**

Here the CE terminal works as a data server, i.e. in the background all driver data are sent to another computer (PC server), which has the real server functionality. Here data can be archived, alarms and CEL are administered, and any number of clients gets the data. Also the use of other modules such as Recipegroup Manager, Message Control, SQL Server, Extended Trend, etc. is possible.
On the second hand the CE terminal is one of these clients and so gets all online data, screens, alarm messages, etc. from the server.

**In case of a server failure, the CE terminal does the administration of alarms and CEL.**

---

**Attention**

*The CE terminal does not save the alarm and CEL entries, while the server is inactive.*

---

Modules not supported under CE will not work. You have to make sure, that no data for the archives are saved on the CE terminal. The CE terminal does not support the connected clients with data. Clients indicate problems in the communication with a blue square.

Like in the redundant network (server and standby server) also here the primary server is dominant, i.e. after starting the PC server the CE terminal is again the standby server and works as dataserver. Driver data such as HDD data are aligned. The server uses the last valid alarm and CEL list and sends these to all clients (also dataserver). The archiving module on the PC server agan can archive and the other clients align with the server und get data from it. The alignment of system and mathematics driver only works in parts because of technical reasons.

If the **dataserver fails**, the communication problem is indicated with a red square on the elements on the server and all clients. The server will not directly connect to the PLC!

This constellation can also be used universally in a PC network, e.g. when using an inefficient PC directly on the machine, which has the data connection to the process. Data archiving however is not done on this PC but on a zenon server which has the real server functionality in the network.

**Conclusion:** If the dataserver fails, there is no communication with the PLC. All clients indicate disturbed values and no data are archived. If the server fails, also at that time there is no archiving. For the entire time of the failure, there are no archived data. If the server fails, the dataserver takes over the alarm administration, but alarms received or cleared during this time will not be taken over by the server.

**DEFINING THE DATASERVER CONCEPT IN PRACTICE:**

Engineering is done on the PC and the created Runtime files are transported to the server and the CE terminal with Remote Transport. All clients (also the dataserver behaves like a client) are automatically updated, if the project is edited.
Attention

In the project configuration the computer name of the PC has to be entered as the server, the name of the CE terminal as the standby server. Additionally the option Standby as dataserver has to be activated.

The option CE project does not have to be activated. Thus the entire functionality of zenon is available for the project. As only a limited functional range is available on the CE side, functions that are not supported under CE will not be executed there (modules, special functions, etc.).

In order not to confuse the operating personnel by offering them screens and elements on the CE terminal, which will not work or are not supported there, for screens and elements the option Visible under CE can be used in the Editor. So the implementing engineer has the possibility to realise his project in the way, that a part of it is available under CE and another part only on the PC (PC server, other clients, ...).

OTHER LIMITATIONS OF THE DATASERVER:

The system and mathematics driver are handled especially in the dataserver concept (and only here): In the dataserver concept both the system and the mathematics driver only run on the server. So the dataserver gets no values of these drivers. On the dataserver mathematics and systemdriver only start, as soon as the server is stopped. As soon as the server is online again, both drivers again only run on the server. From that time the dataserver gets no data from the system and mathematics driver. So mathematics variables do not work correctly in the dataserver concept.

Global variables of the system driver like Names of current clients, Number of connected clients, Current server are administered by the server. The server does not send these variables to the dataserver. So the data server shows its own local contents in these variables, which is not consistent with the server. The system does not offer these data, so this behaviour cannot be changed.

The only exception are the local variables of the system driver like Free memory, Free harddisk space, etc. These variables are always updated locally on the according computer.
Info

As an alternative to the dataserver concept from version 6.20 upwards the project-overlapping archiving can be used to archive data from different CE terminals. To do this every CE terminal needs a network licence and in the project the CE terminal has to be defined as a server.

*On a PC with a Historian licence, the CE projects are added as sub-projects. In the integration project variables from the sub-projects can be added in the archive configuration. Refer to the help for the archiving for more information.*

4.5 Connection via Activesync or Windows Mobile Device Center

With the help of the Microsoft programs ActiveSync (up to Windows XP) or Windows Mobile Device Center (since Windows Vista), you can establish a connection between an industrial CE terminal and a PC.

- In this manual the connection via ActiveSync is described: Serial connection via Windows XP (on page 35)
- The Windows Mobile Device Center works in the same way: USB connection under Windows 7 (on page 34)

4.5.1 USB connection under Windows 7

At a USB connection between the CE device and a computer under Windows 7:

1. make sure that a connection to the Internet is possible
2. connect both devices via USB cable
3. at an existing internet connection the Windows Mobile Device Center is installed automatically and the connection is established
4. You can transfer data as described in chapter Update of Windows CE Runtime (on page 39).
If there is no active Internet connection at the USB connection, there is no automatic installation and configuration. In this case:

- establish the Internet connection
- go to the Device Manager in the Control Panel
- right click on the unknown device
- select update driver software
- Windows installs the drivers
- Windows installs the Windows Mobile Adapter and with this the Windows Mobile Device Center

4.5.2 Serial connection under Windows XP

For this manual for the serial connection under Windows XP the following is true:

- As communication type only a serial point to point connection is covered.
- As operating system for the CE Terminal Windows CE 5.0 or CE 6.0 is a prerequisite.
- Other operating systems are not discussed.
- In the example the connection is established serial via a null modem cable.

Configuration PC

First Activesync has to be installed. Load the appropriate version from the Microsoft Download Center (http://www.microsoft.com/downloads/details.aspx?FamilyID=9e641c34-6f7f-404d-a04b-dc09f8141141&displayLang=de) and install it to any directory. Take care that the installed version supports the desired CE version.

As a default Activesync tries to establish a connection on all COM ports and USB ports one after the other. If there has not been a connection before, you must start the connection on the CE device and the PC at the same time. At that a successful connection establishment is not certain.
**Recommendation:** At the PC add the following entries to the registry so that Activesync only searches the COM port you defined:

```
[HKEY_LOCAL_MACHINE/SOFTWARE/Microsoft/Windows CE Services]
SerialPort=COM1
```

Start Activesync and set the COM port via *File -> Connection properties*:

![Configuration CE](image)

**Configuration CE**

**CREATE NEW CONNECTION**

First you have to create a new connection on the CE panel. To do this start the following program on the CE panel: `/windows/remnet.exe`

1. Configure a new serial connection.
2. Make new connection
3. Enter a name and select Direct Connection
4. Click Next.
5. Select a free serial RS232 port, where you can connect the null modem cable to.
6. Click Configure.
7. Port Settings (Connection Preferences):
a) Baud rate: 19200
   If no connection existed before, we recommend 19200 baud, as Activesync works with this as a default. After that you can increase the baud rate to 115200.

b) Data bits: 8

c) Parity: None

d) Stop bits: 1

e) Flow control: Hardware

8. Close program Remnet.

REGISTER COMMUNICATIONS

In the next step you must start dialog Communications in the Control Panel at the CE terminal.

1. In tab PC Connection activate property Enable direct connections to desktop computer.

2. Click on button Change and select the connection which you have established before in program Remnet.

3. Confirm all dialogs with ok and close the Control Panel.

SAVE SETTINGS

Permanently save the changes in the CE registry of your CE device. Otherwise all the changes will be lost with a restart of the panel!

Each CE terminal has its own tool for saving, e.g. regflush.exe, flushreg.exe, savereg.exe etc. If you find no possibility to save the Registry, contact your hardware manufacturer.

Start communication

CONNECT DEVICE

Connect the CE panel with the PC using a null modem cable.

- PC: The interface configured in Activesync
- **CE**: The interface configured in Remnet

**Attention**: Activesync only accepts a correctly allocated null modem cable!

*Pin allocation of a null modem cable:*

<table>
<thead>
<tr>
<th>A-Seite</th>
<th>B-Seite</th>
</tr>
</thead>
<tbody>
<tr>
<td>9-polig</td>
<td>25-polig</td>
</tr>
<tr>
<td>2 TxD</td>
<td>2 RxD</td>
</tr>
<tr>
<td>3 RxD</td>
<td>3 TxD</td>
</tr>
<tr>
<td>4 RTS</td>
<td>5 CTS</td>
</tr>
<tr>
<td>5 CTS</td>
<td>6 GND</td>
</tr>
<tr>
<td>6 GND</td>
<td>7 RTS</td>
</tr>
<tr>
<td>7 DTR</td>
<td>8 DTR</td>
</tr>
<tr>
<td>8 DTR</td>
<td>9 DTR</td>
</tr>
</tbody>
</table>

**START COMMUNICATION**

Start program `\windows\repllog.exe` on the CE device.

As soon as the icon in the status bar on the PC becomes green, the connection is established. A dialog is displayed in which you can decline the partnership and only sign in the panel as guest.

With **File -> Search** in the Activesync program you now can directly access the CE device, create directories, copy files, etc.

**Hint**: Files like for instance the `zenon6.ini` cannot be opened directly on the CE device. These must first be copied to the PC, edited there and then copied back. You can ignore the message about file converting when copying back. This converting is necessary for some files, e.g. Office files.

With this Activesync connection you now can copy the Transport Service to the CE panel using the CE Runtime Update Tool. You can find details in Update Windows CE Runtime (on page 39) chapter.

---

**Attention**

*The communication only works via repllog.*

*Even if you double click the connection on the CE panel via `\windows\remnet.exe`, it looks like the connection is being established - it does not.*
Troubleshooting

If no connection is established, check whether:

- the CE panel or the PC are connected to the correct COM port.
- a correct null modem cable is used
- on the CE device all settings very carried out as described (on page 36)
- the COM port you use on the CE device really is a RS232 port and not a RS485/422 port

FAQ

<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activesync always open window &quot;Create connection&quot;.</td>
<td>Execute the correct registry file.</td>
</tr>
<tr>
<td>On the computer I always get the message that the device has not been recognized.</td>
<td>Check whether a correct null modem cable (on page 37) is used.</td>
</tr>
<tr>
<td>Activesync becomes green, but nothing works!</td>
<td>On the CE panel the connection probably was started with doubleclicking it in Remnet.exe.</td>
</tr>
<tr>
<td></td>
<td>Start the connection with Repllog.exe.</td>
</tr>
<tr>
<td>How can I check, if I defined the correct COM port on the CE side?</td>
<td>Deactivate the serial COM port in Activesync under File - &gt;Connection Settings.</td>
</tr>
<tr>
<td></td>
<td>Check the connection via the COM port with a terminal program. (Up to Windows XP hyper terminal is included in the delivery of the operating system.)</td>
</tr>
<tr>
<td></td>
<td>If you then start the connection via CE Repllog.exe, for each retry you will see CLIENT in the terminal.</td>
</tr>
</tbody>
</table>

4.5.3 Update Windows CE Runtime

To perform an update of Windows CE Runtime:
- make sure that the zenon Transport Service (SysSrvCE.exe) runs in the CE device
- make sure that you do not have established a remote connection via the zenon Editor to the device
- In the zenon Menu, select Options and then Update Windows CE Runtime.
- The dialog for transfer of Runtime files opens
- configure the link
- define the data you want to transfer
- choose the appropriate version
- start the update

**CONFIGURE CONNECTION**

You can configure the connections to the Windows CE device in the tab **Connection**.

![Configuration image]"
### Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Serial</strong></td>
<td>Settings for serial connection with Windows CE device, you have to select a port.</td>
</tr>
<tr>
<td><strong>TCP/IP</strong></td>
<td>Settings for TCP/IP-connection to the Windows CE device.</td>
</tr>
<tr>
<td><strong>Adress</strong></td>
<td>IP adress.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>Name.</td>
</tr>
<tr>
<td><strong>Syssrvce.exe starts with these settings</strong></td>
<td>Settings for starting syssrvce.exe.</td>
</tr>
<tr>
<td><strong>Serial</strong></td>
<td><em>Active</em>: serial connection selected, port must be selected.</td>
</tr>
<tr>
<td><strong>TCP/IP</strong></td>
<td><em>Active</em>: TCP/IP-connection selected.</td>
</tr>
<tr>
<td><strong>Connection with MS ActiveSync</strong></td>
<td>Settings for connection via MS ActiveSync</td>
</tr>
<tr>
<td><strong>Use MS ActiveSync for initial transport of syssrvce.exe</strong></td>
<td><em>Active</em>: syssrvce.exe is transferred during the first transport via MS ActiveSync.</td>
</tr>
<tr>
<td><strong>Destination folder</strong></td>
<td>Target folder.</td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td>Opens online-help</td>
</tr>
<tr>
<td><strong>Save</strong></td>
<td>Saves all changes.</td>
</tr>
<tr>
<td><strong>Exit</strong></td>
<td>Closes the update CE-tool and reminds you before to save unsaved changes.</td>
</tr>
</tbody>
</table>

**DEFINE FILES YOU WANT TO TRANSFER**
<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Files to update</td>
<td>Files to be transferred.</td>
</tr>
<tr>
<td>HMI Runtime</td>
<td>Active: Transfers zenon files to the target device. Default: active</td>
</tr>
<tr>
<td>PLC Runtime</td>
<td>Active: Transfers zenon Logic files to the target device. Default: inactive</td>
</tr>
<tr>
<td>OS system files</td>
<td>Active: Transfers necessary files for the OS. Default: active</td>
</tr>
<tr>
<td>Update zenon6.ini</td>
<td>Transfers zenon 6.ini to the target device. This way, the license information of the target device is also changed.</td>
</tr>
</tbody>
</table>

**Options**

**Language**

Desired target system language. Default: English

**HMI drivers**

Selection of HMI drivers for transfer.

**Available**

List of available drivers.

**Selected**

List of selected drivers.

**Add**

Adds chosen drivers to the list of selected drivers.

**Add all**

Adds all drivers to the list of selected drivers.

**Remove**

Removes chosen drivers from the list of selected drivers.

**Remove all**

Removes all drivers from the list of selected drivers.

**Help**

Opens online-help

**Save**

Saves all changes.

**Exit**

Closes the update CE-tool and reminds you before to save unsaved changes.

**SELECT VERSION**

Select the correct version in the tab Versions if it wasn’t automatically recognized.
### Parameters | Description
--- | ---
**WinCE version** | Version of the target device Windows CE OS. Click the button to open a drop-down list for selection.
**Processor type** | Processor of the device.
**Source path** | Path to the folder that contains the files. Click the button ... and a dialog opens to select a folder.
**New** | Inserts a new, empty entry in the list.
**Delete** | Deletes the selected entry from the list.
**Test** | Verifies settings.
**Help** | Opens online-help.
**Save** | Saves all changes.
**Exit** | Closes the update CE-tool and reminds you before to save unsaved changes.

---

**START UPDATE**

To establish a connection:
- Click on the button **Start** on the tab **Update**.

- The data that shall be transferred is verified and displayed in a window.

- Start the transfer to the target device by clicking on the button **Next**.
If the transfer cannot be initiated because files are missing, an error message with a list of missing files pops up:

- If you get the error message "The current update was not completed", the update was interrupted or not executed properly.

Info

If you want to replace zenVNCServer.exe via update, it is terminated and restarted after the update. For this the file zenVNCServerCE.exe must contain the
the following entry in the UpdateCE.ini in section [SOURCES_FILESGENERAL] (exists per default):

- zenVNCServerCE.exe
- zenVNCServerCE.exe
4.6 Recipegroup Manager

In order to use the recipe group manager under Windows CE, the data of the RGM must be stored alternatively to the MS Access database. For Windows CE the data is stored in a binary way in a file structure.

If you activate in Project properties -> General check box Windows CE project, the data for the RGM are automatically stored in a binary way. You can define the binary saving of the data manually independent of the CE project via: Property recipe group -> Recipegroup Manager -> RGM data storage -> binary files CE compatible).

⚠️ Attention

A conversion from MS Access database to binary or vice versa is not provided.

Already existing RGM data are not converted! If necessary you must export the data to XML prior to the conversion. After that you can convert the project and import the data in the new data storage.

CHANGING THE DATABASE

If you selected for the RGM in property RGM data storage MS ACCESS DB as database and you then activated check box Windows CE project, a hint for the conversion is displayed:

To conserve the data of the present database:

1. export the data to XML
2. convert the database
3. import the XML file
FILTER DIALOG IN THE RUNTIME

If you activate property **Show dialog in the Runtime** at the options of the Recipe value list in the screen switch, there are only restricted options available in Windows CE:

- Recipe filter
- Column settings (for recipe table)

**Recipe selection**, **Equipment modeling** and column settings for the **recipe list** are not available.

MULTI-USER PROJECTS

In multi-user projects you can check out binary data and MS Access database independent of each other.

In window **Under construction** always the state of the type of storage set on this computer is displayed. If binary files are used you cannot see that the Access database is also checked out.

With this the following scenario is possible:

- on PC A the Access database is checked out
- on PC B the CE project is activated and therefore converted to binary data
- on PC B the binary files are checked out
- on PC B the changes are applied and then synchronized with PC A
- with this PC A is also converted to binary files
- the Access database however stays checked out on PC A
- only when PC B converts back to Access database you can see that the Access database is checked out on PC A

4.7 Transparency

In Windows CE GIF files can be displayed transparent. In contrast the transparent setting in the extended graphic functions is not available in Windows CE.

To display a transparent GIF in Windows CE:
- file IMGDECEMP.dll must be available at the target device.
  If the file is missing, you can request it via <CD_MAILSUPPROT>.

- Transparency can be either 0% or 100%. No intermediate values are possible.

---

**Info**

*Transparency for PNG files from 0% to 100% in Windows CE in no part of zenon. It can however be used under certain prerequisites.*

- zenon Version 6.22 SP1 or higher is not used
- **Alpha blending** must already be implemented by the manufacturer of the target device; COPA-DATA does not provide any support for this

---

### 4.8 Pocket PC and Windows Mobile Edition

If you quit zenon with X on a Pocket PC or on a Windows Mobile device, please notice that the application does not quit but keeps on running in the background.

In order to avoid an additional start of zenon on your device, we have created the tool **Start_CERT.exe** which brings the application into the foreground if it is already running or otherwise starts it as usual.

We recommend to start the Runtime on a Pocket PC or Windows Mobile platform by using **Start_CERT.exe** instead of a direct link.

**Note:** Pocket PC will not be supported for zenon version 7 and above.